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Quick Start
If you've ever played a Windows solitaire game, you won't have much trouble playing this one.        
Simply click on the name of the game you want to play (such as Forty Thieves).

To find out the rules of a particular game, goto the help menu, click on the help button on the toolbar, 
or press F1.    If you become familiar with how the "Solitaire Wizard" works, you can also find the 
rules by choosing Properties from the Game menu.

To move the cards, drag them with the left mouse button and drop them where you want them.    Or, 
you can click on the right mouse button to have the computer automatically move the card for you.

Note that you can undo and redo moves by clicking on the toolbar.    You can also start a new game, 
select a game position by number, and exit from the toolbar.    If you don't like the toolbar, (for 
instance, if you are in 640x480 resolution and it takes up too much valuable room), you can turn it off 
in the options menu in the main screen.

The autoplay option will automatically play cards to the foundation for you, if it is possible to move 
them.    This can be a great timesaver, but if you want this option turned off, you can do so in the 
options menu of each game.

When you exit a game, the game is saved automatically for you and you can resume the game right 
where you left off.    If you don't want games saved, you can turn this off as well from the options 
menu of the main screen.

Have fun!



General Information
Napoleon Solitaire is a collection of solitaire games based on the classic game Napoleon at St. 
Helena (also known as Forty Thieves, Big Forty, Roosevelt at San Juan and other names).    In this 
collection, this stem game is called Forty Thieves.    It is a two deck solitaire game, with 8 foundations 
that are built from ace to king, and ten tableaus that are built down by suit.    The tableaus begin with 
4 cards each (40 cards total, the 40 "thieves").    The rest of the cards are placed face down in a 
stock pile, which is turned over one at a time onto a discard pile.    Only one card can be moved from 
pile to pile at a time.    The game is won if all 104 cards in the deck are moved to the foundations.

The other games in the collection are simply variations on the rules.    Sometimes the number of 
tableau piles is changed, or the number of cards dealt to each pile, or whether these cards are dealt 
face up or down.    Some games allow more than one card at a time to be moved in the tableau, if the 
cards form the proper descending sequence.    Some games have different methods of building on 
the tableau, such as by alternate color rather than by suit.

For example, the game Josephine is simply Forty Thieves, with one change: you can move any 
group of cards in the tableau that is a descending sequence of cards of the same suit    (a 4, 3, and 2 
of hearts, for example).    This makes the game easier to win.    Most of the variations were invented 
because Forty Thieves is very difficult to win.

It is not certain, but it is believed that Forty Thieves dates back to Napoleon's time, hence the name. 
Many of the variations were invented in the 1890s and 1900s.

The Game Wizard allows you to create your own Napoleon Solitaire type games.    It gives you 
control over the rules.    You can choose the number of tableau piles (from 4 to 13), the number of 
cards dealt to each pile (from 1 to 9), how many of these are face down, how the tableau piles are 
built down (by suit, by alternate color, by the same color, by any color but the same, or down 
regardless).    You can control whether moving multiple cards from one tableau pile to another is 
allowed.    And you can give your own name to a set of rules and play the game over and over.

Finally, all the games (including the ones you create with the Game Wizard) have all the features that 
every game in my other solitaire program, Pretty Good Solitaire, have.    You have full undo/redo, 
autoplay, selectable card backs and background color.    Win/loss records are kept, and games in 
progress are saved automatically when you exit the program.
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Notes about the AutoPlay feature
AutoPlay
AutoPlay is the feature that moves playable cards from the tableau to the foundations automatically. 
(Only those games with foundations have this feature, of course.)      This feature can be a great time 
and effort saver, and I highly recommend its use.

However, there are a couple of things about AutoPlay that you should be aware of.    First, in some 
games it is not necessarily a good idea to automatically play every possible card to the foundations. 
In these games, the best strategy is to keep the foundations pile roughly even with each other (for 
example, don't play the clubs foundation pile up to 5 or 6 when the ace of hearts hasn't come out 
yet).    Because of this, the AutoPlay feature will NOT play a card to the foundations if it determines 
that that card might be necessary for play on the tableau.    You can, of course, override this if you 
wish by playing the card to the foundations yourself.    But remember, if AutoPlay doesn't move a card 
that it could move, there's a reason.



Auto Play
By selecting Auto Play from the Options menu, any cards in the tableau or cells that can be legally 
moved to the foundation are automatically moved there.    This speeds up play.

Important Notes about the AutoPlay feature



Windows 95 Issues
Napoleon Solitaire is a Windows 3.1 program.    However, like most Win3.1 programs, it runs fine in 
Windows 95.    There are a few things Win95 users should be aware of, however.

If you run Win95 with a screen resolution of 800x600 or more, you should have no difficulties.    You 
may want to resize the game window to your liking.    I recommend placing the taskbar at either the 
top or bottom of the screen, as most of the games like as much horizontal space as possible.

Screen Resolution Issues
The main problems with Napoleon Solitaire and Windows 95 occur at 640x480 resolution.    The 
problem is the taskbar, and how much valuable space it takes up.    This screen just ain't big enough 
for the both of 'em.      I recommend hiding the taskbar (this can be done by positioning the mouse at 
the top of the taskbar and pulling down over it, or by clicking on the Start button, selecting Settings | 
Taskbar, and turning off "Always on Top"). Better yet, if you have a machine capable of running 
Win95, you probably can run it at 800x600.



Screen Resolution Issues
Napoleon Solitaire was developed to run in 800x600 mode or higher.    If you run it in higher 
resolutions, you can resize the game window to make it bigger.    Napoleon Solitaire will then adjust 
to the bigger window the first time you do a "New Game".    This will spread out the piles. 

If you run it in 640x480 resolution, only a few of the games (the ones with only 8 tableau piles) will 
run.

You can adjust the size of the game window at any time.    Napoleon Solitaire will always adjust to a 
new window size after a "New Game". 

Note: If you switch resolutions and play a game that was previously played at another resolution, you 
will need to "New Game" to get Napoleon Solitaire to adjust to the new resolution.



Benefits of Registration
This program is shareware.    As such, you have a limited evaluation period in which to determine 
whether you wish to register this program.      Continued use beyond the evaluation period requires 
registration.    The registration price for this program is only $15 (plus $3 if you want a disk).

If you do register this program, this is what you will get for your money:

· A registration code and instructions on how to input this code to register your copy of Napoleon 
Solitaire.    This process will get rid of the registration notices and allow you to play an unlimited 
number of games.    (Your registration code will be sent by e-mail if you specify an e-mail 
address; otherwise, it will be sent by regular mail).    You will also receive a 3.5 inch diskette by 
mail if you include the $3 shipping fee.

· Upgrades to all future versions distributed by e-mail.    Be sure to include your e-mail address on 
the registration form if you wish to take advantage of this benefit.    Upgrades can also be 
downloaded from the Napoleon Solitaire internet site.    Your registration code will work for all 
future versions.

· Technical support, via e-mail.

Registration by Mail Form
Registration online at http://www.goodsol.com
Association of Shareware Professionals Ombudsman Statement



Registration Form
Napoleon Solitaire 2.1
Ordering by check:    To order by check send this order form and a check to:

Goodsol Development
PO Box 9155
Springfield IL    62791-9155    USA

To print this form, click on Print Topic in the File pull-down menu.    Payment must be in US dollars 
drawn on a US bank, or you can send international postal money orders in US dollars (Canadian 
dollars also accepted, but please calculate exchange rate).

Prices:        Napoleon Solitaire        ____    copies @ $15 each =    $__________

              shipping for 3.5 inch diskette (optional)                        $3        =    $__________
  
                                    Total enclosed                                                                                                $__________

Name________________________________________________________

Address______________________________________________________

City____________________________State/Province__________________

Zip Code/Postal Code_____________Country________________________

E-Mail address_________________________________________________

Where did you hear about or find Napoleon Solitaire?

______________________________________________________________

Suggestions:

______________________________________________________________

______________________________________________________________

______________________________________________________________





ASP Ombudsman Statement
This program is produced by a member of the Association of Shareware Professionals (ASP). ASP 
wants to make sure that the shareware principle works for you. If you are unable to resolve a 
shareware-related problem with an ASP member by contacting the member directly,    ASP may be 
able to help. The ASP Ombudsman can help you resolve a dispute or problem with an ASP member, 
but does not provide technical support for members' products. Please write to the ASP Ombudsman 
at 157-F Love Ave, Greenwood, IN    46142 USA, FAX 317-888-2195, or send email to omb@asp-
shareware.org.



How to Play
All the games in Napoleon Solitaire follow the same basic format.    They all have a foundation, 
tableau, stock pile, and waste pile.    To see the specific rules of a particular game, select Properties 
from the Game menu.

Foundation
The foundation piles are always located at the top of the screen, marked with X's when they are 
empty.    There are 8 foundation piles, one for each of the suits in 2 decks.    The foundation piles are 
built up in suit, beginning with an ace and moving up to Kings.

Tableau
The tableau piles are located below the foundation piles.    There are between 4 and 13 tableau piles, 
depending on the particular game.    Anywhere between 1 and 9 cards are dealt to each tableau pile 
at the beginning of the game.    The tableau piles are always built down.    For example, a 6 can be 
played on a 7.    Depending on the game, the cards may have to be the same suit, or of opposite 
colors, or some other method of building.    To see how the tableaus of a particular game are built, 
select Properties from the Game menu, and see the "Tableau Building Method" property.

In some games, only one card at a time can be moved from one tableau pile to another.    In other 
games, groups of cards that are in a descending sequence and meet the tableau building method 
property may be moved as a unit.    Again, check the Properties from the Game menu, and see the 
"Move groups of cards as a unit" property.    Cards can be moved from one pile to another by 
dragging.    Cards can also be moved from the Tableau to the Foundations by double-clicking on the 
card in the Tableau.

Stock Pile
The stock pile is located at the upper left hand corner of the screen (except when there are only 8 
tableau piles, in which case it is located in the lower left hand corner).      All the cards not dealt to the 
tableau are placed face down in the stock pile.    These cards can be turned over one at a time by 
clicking on the stock pile.    The top card of the stock pile is then turned over and moved to the waste 
pile.    The stock pile may only be run through once during a game.

Waste Pile
The waste pile contains all unused cards from the stock pile.    As cards are turned over from the 
stock pile, they are placed in the waste pile.    The top card of the waste pile is always available for 
play on either the tableau or the foundation.

Objective
The objective of the game is to get all cards from both decks in the foundation piles.    When all cards 
are in the foundation piles, the game is won.    If the stock pile is empty and all cards cannot be 
played to the foundations, the game is lost.

Forty Thieves
Little Napoleon
Congress



Diplomat
Indian
Josephine
Maria
Rank and File
Midshipman
Number Ten
Limited
Blind Alleys
Australian Patience
Single Rail
Double Rail
Little Forty
Giant
Waterloo
Napoleon's Square
Corona
Blockade



Forty Thieves
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 10 Tableau piles (below foundations) - 4 cards per pile dealt face up at the beginning of the 
game.    Build down in suit.    Only the top card of each pile may be moved.    Spaces filled by any 
card.

· Stock (top left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Note: To review the rules of any game, select Properties from the Game menu.



Little Napoleon
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 8 Tableau piles (below foundations) - 4 cards per pile dealt 3 face down, 1 face up at the 
beginning of the game.    Build down regardless of suit. Groups of cards can be moved from one 
tableau pile to another, but only if they form a descending sequence all of the same suit..    
Spaces filled by any card.

· Stock (bottom left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Note: To review the rules of any game, select Properties from the Game menu.



Congress
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 8 Tableau piles (below foundations) - 1 card per pile dealt face up at the beginning of the game. 
Build down regardless of suit.    Only the top card of each pile may be moved.    Spaces filled by 
any card.

· Stock (bottom left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Congress is closely related to Diplomat.

Note: To review the rules of any game, select Properties from the Game menu.



Diplomat
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 8 Tableau piles (below foundations) - 4 cards per pile dealt face up at the beginning of the game. 
Build down regardless of suit.    Only the top card of each pile may be moved.    Spaces filled by 
any card.

· Stock (top left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Diplomat is very similar to Congress.

Note: To review the rules of any game, select Properties from the Game menu.



Indian
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 10 Tableau piles (below foundations) - 3 cards per pile dealt 1 face down, 2 face up at the 
beginning of the game.    Build down in any suit but the same.    Only the top card of each pile 
may be moved.    Spaces filled by any card.

· Stock (top left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Indian is very much like Forty Thieves, except that there are fewer cards in the original tableau, and 
the method of tableau building is by any suit but the same.    It makes for a considerably easier game.

Note: To review the rules of any game, select Properties from the Game menu.



Josephine
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 10 Tableau piles (below foundations) - 4 cards per pile dealt face up at the beginning of the 
game.    Build down in suit.      Groups of cards can be moved from one tableau pile to another, 
but only if they form a descending sequence all of the same suit..    Spaces filled by any card.

· Stock (top left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Josephine is very much like Forty Thieves, except that cards forming a descending sequence of the 
same suit may be moved as a unit.    It makes for a somewhat easier game.

Note: To review the rules of any game, select Properties from the Game menu.



Maria
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 9 Tableau piles (below foundations) - 4 cards per pile dealt face up at the beginning of the game. 
Build down in alternate color.    Only the top card of each pile may be moved.    Spaces filled by 
any card.

· Stock (top left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Maria (also sometimes known as Maria Luisa) is closely related to Midshipman.

Note: To review the rules of any game, select Properties from the Game menu.



Rank and File
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 10 Tableau piles (below foundations) - 4 cards per pile dealt 3 face down 1 face up at the 
beginning of the game.    Build down by alternate color.      Groups of cards can be moved from 
one tableau pile to another, but only if they form a descending sequence in alternate colors.    
Spaces filled by any card.

· Stock (top left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Rank and File is one of the classic variations on Forty Thieves.    The differences are that 3 of the 4 
cards in the original tableau are dealt face down, the tableaus are built down by alternate color 
instead of by suit, and groups of cards forming a descending sequence in alternate colors can be 
moved as a unit.    Rank and File is also very similar to Number Ten.

Note: To review the rules of any game, select Properties from the Game menu.



Midshipman
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 9 Tableau piles (below foundations) - 4 cards per pile dealt 2 face down 2 face up at the 
beginning of the game.    Build down by any suit but the same.    Only the top card of each pile 
may be moved.    Spaces filled by any card.

· Stock (top left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Midshipman is very similar to Maria.    The differences are that two cards in the original tableau are 
dealt face down, and the tableaus are built down by any suit but the same, rather than by alternate 
colors.    It makes the game slightly easier to win.

Note: To review the rules of any game, select Properties from the Game menu.



Number Ten
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 10 Tableau piles (below foundations) - 4 cards per pile dealt 2 face down 2 face up at the 
beginning of the game.    Build down by alternate color.      Groups of cards can be moved from 
one tableau pile to another, but only if they form a descending sequence in alternate colors.    
Spaces filled by any card.

· Stock (top left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Number Ten is one of the classic variations on Forty Thieves.    The differences are that 2 of the 4 
cards in the original tableau are dealt face down, the tableaus are built down by alternate color 
instead of by suit, and groups of cards forming a descending sequence in alternate colors can be 
moved as a unit.    Number Ten is also very similar to Rank and File.

Note: To review the rules of any game, select Properties from the Game menu.



Limited
2 Decks.

To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 12 Tableau piles (below foundations) - 4 cards per pile dealt face up at the beginning of the 
game.    Build down in suit.    Only the top card of each pile may be moved.    Spaces filled by any 
card.

· Stock (top left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Limited is very much like Forty Thieves, except that the tableau consists of twelve piles of four cards 
each.    It makes for a somewhat easier game.    Note also that of all the games, Limited is the most 
(ahem) limited, in the sense that it requires a screen resolution of at least 1024x768, so that all 12 
piles can fit across the screen.

Note: To review the rules of any game, select Properties from the Game menu.



Blind Alleys
1 Deck.

Objective
To move all the cards to the Foundations.

Layout
· 4 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 6 Tableau piles (below foundations) - 3 cards per pile dealt 2 face down 1 face up at the 
beginning of the game.    Build down by alternate color.    Groups of cards may be moved if they 
form a sequence down by alternate color.    Spaces filled by any card.

· Stock (top left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Note: To review the rules of any game, select Properties from the Game menu.



Australian Patience
1 Deck.

Objective
To move all the cards to the Foundations.

Layout
· 4 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 7 Tableau piles (below foundations) - 4 cards per pile dealt face up at the beginning of the game. 
Build down in suit. Groups of cards may be moved regardless of sequence.    Spaces filled by 
Kings only.

· Stock (top left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Note: To review the rules of any game, select Properties from the Game menu.



Single Rail
1 Deck.

Objective
To move all the cards to the Foundations.

Layout
· 4 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 4 Tableau piles (below foundations) - 1 card per pile dealt face up at the beginning of the game. 
Build down regardless of suit.    Groups of cards may be moved if they are in sequence down 
regardless of suit.    Spaces filled by any card.

· Stock (top left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Note: To review the rules of any game, select Properties from the Game menu.



Double Rail
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 5 Tableau piles (below foundations) - 1 card per pile dealt face up at the beginning of the game. 
Build down regardless of suit.    Groups of cards can be moved if they are in sequence down 
regardless of suit.    Spaces filled by any card.

· Stock (top left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Note: To review the rules of any game, select Properties from the Game menu.



Little Forty
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 10 Tableau piles (below foundations) - 4 cards per pile dealt face up at the beginning of the 
game.    Build down regardless of suit.    Groups of cards can be moved if they are in sequence 
down by suit.    Spaces filled from the Stock or Waste only.

· Stock (top left) - turn over 3 cards at a time to the Waste pile by clicking.    3 redeals.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Note: To review the rules of any game, select Properties from the Game menu.



Giant
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 8 Tableau piles (below foundations) - 1 card per pile dealt face up at the beginning of the game. 
Build down by alternate colors.    Groups of cards can be moved if they are in sequence down by 
alternate colors.    Spaces filled by any card.

· Stock (top left) - Deals one card to each tableau pile by clicking.    No redeal.

Note: To review the rules of any game, select Properties from the Game menu.



Waterloo
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 6 Tableau piles (below foundations) - 1 card per pile dealt face up at the beginning of the game. 
Build down regardless of suit.    Groups of cards can be moved if they are in sequence down 
regardless of suit.    Spaces filled by any card.

· Stock (bottom left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Note: To review the rules of any game, select Properties from the Game menu.



Napoleon's Square
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 12 Tableau piles (below foundations) - 4 cards per pile dealt face up at the beginning of the 
game.    Build down by suit.    Groups of cards can be moved if they are in sequence down by 
suit.    Spaces filled by any card.

· Stock (top left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Note: To review the rules of any game, select Properties from the Game menu.



Corona
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 12 Tableau piles (below foundations) - 3 cards per pile dealt face up at the beginning of the 
game.    Build down by suit.    Groups of cards cannot be moved.    Spaces filled by from Stock or 
Waste only.

· Stock (top left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Note: To review the rules of any game, select Properties from the Game menu.



Blockade
2 Decks.

Objective
To move all the cards to the Foundations.

Layout
· 8 Foundation piles (across top with X's) - build up in suit from Ace to King.

· 12 Tableau piles (below foundations) - 1 card per pile dealt face up at the beginning of the game. 
Build down regardless of suit.    Groups of cards can be moved if they are in sequence down by 
suit.    Spaces filled by any card.

· Stock (top left) - turn over 1 card at a time to the Waste pile by clicking.    No redeal.

· Waste (next to Stock) - top card is available for play on the Foundations or Tableau.

Note: To review the rules of any game, select Properties from the Game menu.



Features
Select Random Game
Add New Player
Delete Current Player
Delete Current Game
Background Color
Game Statistics
Game Saving

Individual Game Features
New Game
Restart Game
Undo
Redo
Card Backs
AutoPlay



Select Random Game
The Select Random Game option selects one of the games at random to play.



Add New Player
The Add New Player option adds a new player to the player list.    You will be asked for a name for 
the new player.



Delete Current Player
Delete Current Player deletes the currently selected player from the player list.    You will be asked to 
confirm the action.



Delete Current Game
The Delete Current Game deletes games that were created and named by the Game Wizard.    First 
you must click on game in the box at the right hand side of the screen.    This starts the game.    Exit 
the game, and with the game name still highlighted in the box, select "Delete Current Game".    The 
game will be deleted.    Note that any game can be recreated by choosing its rules in the Game 
Wizard and naming it.



Background Color
The Background Color option allows you to change the backgound color for each game.    Select the 
game in the box at the left and the current background color for that game will be shown.    To change 
the color for that game, click on the Change Color button.    To save your changes, click OK.    To 
abandon any changes, click Cancel.



Game Statistics
The Game Statistics option, when set, saves win and loss statistics for each game, for each player.    
To see your statistics for an individual game, start the game and select Statistics from the Options 
menu.    You can reset the statistics at any time.

If you do not want statistics of your performance kept, simply unselect this option.    Your current 
statistics will remain, but no new results will be added until you select the option again.

Different player names can set this option individually.



Game Saving
The Game Saving option, when set, saves the game positions of every game upon exit.    This 
means that if you are interrupted during play, and exit the game, you can return to the same position 
the next time you play.

When this option is not set, the game positions are not saved.    Turning off the option will also delete 
all currently saved positions.

Different player names can set this option individually.



New Game
Selecting New Game from the Game menu will deal out a new deck.    If you are in the middle of a 
game and Game Statistics is on, a loss will be added to your statistics.



Restart Game
Selecting ReStart Game from the Game menu will start the current game over again from the 
beginning.    This will not affect your statistics.



Undo
Selecting Undo from the Options menu will undo the last move.    Moves can be undone back to the 
beginning of the game (of course, ReStart Game would be easier in this case).



Redo
Selecting Redo from the Options menu will replay any moves you have undone,    in case you 
change your mind.



Card Backs
Selecting Card Backs from the Options menu allows you to select between 6 different card backs.    
Card Backs are only visible in games where some cards are face back.    A card back change will not 
go into effect until a new game is started.



Off to See the Wizard
Napoleon Solitaire allows you to create hundreds of thousands of different solitaire games by 
changing the rules of the games.    You can invent your own games, name them, and change them to 
suit your taste.

The Napoleon Solitaire Wizard is divided into four parts:    Deck, Tableau, Foundation, and Deal.    
Each deals with a different aspect of the game.

Deck
The Deck portion of the Wizard has two fields, Save Game Name and Number of Decks.

Save Game Name
In the box for Save Game Name, type the name of the game you wish to create.    You can give it any 
name you wish (except don't give it the name of an existing game).    If you want to edit the rules of a 
game you have already created, you can select the name of that game in the drop-down box.

Number of Decks
In the Number of Decks box, choose whether you want to play a game that uses 1 deck of cards (52 
cards), or 2 decks of cards (104 cards).

Number of Tableau Piles
Determines how many tableau piles there will be in the game.    This can be anywhere from 4 to 13. 
The number of tableau piles will also determine what Windows screen resolutions the game will run 
in.

· 11 to 12 tableau piles - requires at least a 1024 x 768 resolution.

· 9 to 10 tableau piles - requires at least a 800 x 600 resolution.

· 4 to 8 tableau piles - runs in any resolution, including 640 x 480.

The program will not change Windows resolutions for you. In Windows 3.x, you must go to Windows 
Setup to change the resolution.    In Windows 95, right-click on the desktop and select Properties | 
Settings.

When you are finished with these fields, click on the Next button, or click on the Tableau tab to move 
on.

Tableau



Tableau
The Tableau part of the Wizard has 5 fields, Number of Cards in each Tableau Pile, Number of Face 
Down Cards in each Tableau Pile, Method of Tableau Building, Empty Tableau Filled By, and Groups 
of Cards may be Moved as a Unit.

Number of Cards in each Tableau Pile
Determines how many cards will be dealt to each Tableau pile at the beginning of the game.    This 
can be anywhere from 1 to 9.

Number of Face Down Cards in each Tableau Pile
Determines how many cards are dealt face down in each tableau pile. At least one card must be 
dealt face up, so this number can be anywhere from zero to one less than the number of cards in 
each tableau pile.

Method of Tableau Building
Determines how the tableau piles are built down.    The choices are: build down in the same suit only, 
build down in alternate colors, build down in the same color only, build down in any suit but the same 
suit, and build down regardless of suit.

This selection gives you a lot of power over the difficulty level of the game.    Games that require 
cards to be of the same suit are the most difficult, because they are the most restrictive.    The other 
choices become progressively less difficult, with building down regardless of suit the easiest.

Empty Tableau Filled By
Determines how empty piles in the Tableau are filled.    There are four choices: any card or legal 
sequence or cards (no restrictions),    only a King (or one rank below the foundation base, if the 
foundation base is not an Ace),    a card from the stock or waste pile only,    or spaces can't be filled at 
all.

Groups of Cards can be Moved as a Unit
Determines whether you can move more than one card at a time among Tableau piles.    There are 3 
choices:    No, you can only move one card at a time, yes, you can move groups but only if they are 
in a legal sequence (these sequences are chosen in the drop-down box), and yes, you can move 
groups without any restrictions.

When you have completed filling in these fields, click on the next button or on the Foundation tab.

Foundation



Foundation
The Foundation part of the Napoleon Solitaire Wizard has two parts, Foundation Base Card, and 
Foundation Building Method.

Foundation Base Card
Determines what card starts each Foundation pile.    You have two choices: begin all piles with aces 
(choosing this option gives you the further choice of dealing the aces to the Foundations at the 
beginning of the game, or not), or begin all piles with a card rank chosen at random at the beginning 
of the game.    In this case, the first card in the deck is dealt to the first Foundation pile.    All other 
Foundation piles must then begin with the same rank as this card.    (For example, if the card is a 4 
all the other piles must start with 4's and build up).

Foundation Building Method
Determines how the Foundation piles are built up from their base.    There are 4 choices: Build up in 
suit (most usual), build up in alternate color, build up in color,    and build up regardless of suit.

When filling out these fields is complete, click on the next button or the Deal tab.

Deal



Deal
The Deal part of the Napoleon Solitaire Wizard has two parts: Number of Cards Dealt from Stock, 
and Number of Redeals Allowed.

Number of Cards Dealt from Stock
Determines how many and by what method cards will be dealt from the stock pile.    There are three 
choices: deal one card at a time to the stock pile, deal three cards at a time to the stock pile, and 
deal one card to each tableau pile.    In this last case there is no waste pile and there can be no 
redeals.

Number of Redeals Allowed
Determines how many times the waste pile can be turned over and dealt back again as the stock. 
There are 5 choices:    no redeals allowed, only 1 redeal allowed, 2 redeals, 3 redeals, and unlimited 
redeals.    This choice has a big effect on how easy the game is to win.

When you have completed these fields, you are finished with the Wizard.    You can play the game 
you just created by clicking on the Done button.    You can go back and change anything you want by 
clicking on the Previous button, or by clicking on a tab at the top of the screen.    You can abandon 
this game by clicking on Cancel.
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Version 2.0 - released 11/15/96 - added 10 new games and improved the Game Wizard.

Version 2.1 - released 6/15/98 - updated contact information.

Vendor Information
Napoleon Solitaire version 2.1 may be distributed via BBSs, online services, and the Internet, as long 
as all files (NAPSOL2.EXE, NAPSOL2.HLP, QCARD.DLL, CMDIALOG.VBX, README.1ST, 
FILE_ID.DIZ and VENDOR.DOC) are present and unmodified.    It may be not be sold on diskette or 
CD-ROM, either alone or as part of a collection, without the permission of the author.    No fee or 
charge of any kind, not even a "distribution fee", may be made for this program when distributed by 
diskette or CD-ROM without the permission of the author.    Private individuals can copy and 
distribute the program on diskette as long as there is no charge for the program.    Diskette and CD-
ROM vendors should direct inquiries to the author at the postal or email addresses above.



License
Napoleon Solitaire
Copyright © 1996-8 Goodsol Development Inc.    All rights reserved.

License Agreement
You should carefully read the following terms and conditions before using this software.    Your use of 
this software indicates your acceptance of this license agreement and warranty.

Evaluation and Registration
This is not free software.    You are hereby licensed to use this software for evaluation purposes 
without charge for up to 30 days.    If you use this software after your 30 day evaluation period has 
expired a registration fee is required.

Unregistered use of Napoleon Solitaire after the evaluation period is in violation of U.S. and 
international copyright laws.

Distribution
You are hereby licensed to make as many copies of the unregistered version of this software and 
documentation as you wish; give exact copies of the original unregistered version to anyone; and 
distribute the unregistered    version of the software and documentation in its unmodified form via 
electronic means. 

You are specifically prohibited from charging, or requesting donations, for any such copies, however 
made; and from distributing the software and/or documentation with other products (commercial or 
otherwise) without prior written permission, with one exception: magazines may distribute this 
software on a diskette or CD-ROM sold with the magazine, subject to the conditions in this license, 
without specific written permission.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED.



Pretty Good Solitaire
Pretty Good Solitaire 98 is a collection of 200 Windows solitaire games for Windows 95/98/NT, 
including most of the classic solitaire games.    It contains all the same features as Napoleon 
Solitaire, such as autoplay, game saving, statistics, and so on.    The games include Klondike, 
Canfield, FreeCell, Spider, Seahaven Towers, Yukon, Forty Thieves, and many more.    Look for this 
collection in the same place that you found Napoleon Solitaire, or download it from the World Wide 
Web at http://www.goodsol.com.



Napoleon Solitaire
To determine the specific rules for the current game, select Properties from the Game menu.



Registration online
To register Napoleon Solitaire online with a credit card, go to

http://www.goodsol.com
and click on the Register link.    Your credit card will be charged in the name "Northstar Solutions".    
You can order either product #1055, Napoleon Solitaire (without disk) $15, or product #1056, 
Napoleon Solitaire (with disk) $18.






